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PHAÀN MEÀM TÍNH CÖÔÙC CITY – CAS 
( CITY Call Acounting System) 

 
PHAÀN 1 
CAØI ÑAËT PHAÀN MEÀM CITY-CAS 
I.  Caáu hình heä thoáng 

- CPU : Pentium III trôû leân 
- Heä ñieàu haønh : hoã trôï Window 9x, Win Me, Win 2000, Win NT 5.0, Win XP 

 
II. Caøi ñaët chöông trình 

- Copy toaøn boä döõ lieäu treân CD chöông trình vaøo 1 thö muïc treân ñóa cöùng. 
- Vaøo thö muïc Setup, chaïy File Setup.exe 
- Soá serial laø : 7321208-2008 
Sau khi caøi ñaët, chöông trình seõ taïo 1 shortcut CDR Billing System vaøo Folder Startup cuûa 
window, vì theá chöông trình seõ töï ñoäng chaïy khi khôûi ñoäng Window 

 
III. Caøi ñaët Tieáng Vieät : 

- Copy caùc Font trong thö muïc caøi ñaët vaøo thö muïc Windows\Fonts. 
- Click phaûi chuoät choïn Properies . 
- Choïn Appearance  
- Choïn Advanced, Choïn taát caû caùc tieâu ñeà vôùi Fone VK Sans Serif 
- Choïn OK. 
- Môû chöông trình leân vaø chuyeån sang giao dieän tieáng vieät [V]coù treân Toolbar. 
- Sau ñoù taét phaàn meàm vaø môû leân laïi, Luùc naøy giao dieän seõ hoaøn toaøn laø tieáng vieät. 

III. Ñaêng kyù baûn quyeàn phaàn meàm 
Sau khi caøi ñaët xong chöông trình, môû chöông trình phaàn meàm leân.(Löu yù laø chöa logon vaøo chöông 
trình).Môû ñóa CD phaàn meàm ra, sau ñoù vaøo file serial.txt , Coppy doøng soá serial treân ñóa vaø Past 
vaøo phaàn Help - About – Serial key, Sau ñoù nhaán rigistry, Nhaán OK, Sau ñoù taét phaàn meàm vaø môû 
laïi.Phaàn meàm seõ ñöôïc ñaêng kyù vónh vieãn. 
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Phaàn 2 

HÖÔÙNG DAÃN CAØI ÑAËT CAÁU HÌNH HEÄ THOÁNG CITY-CAS ( Ver Office ) 
 
Khi chaïy chöông trình laàn ñaàu tieân, heä thoáng seõ yeâu caàu ñaêng nhaäp Username vaø Password. Söû 
duïng Username vaø Password maëc ñònh laø : 

                         

Username : CITYTELE 
Password : SYSTEM 

I. CAØI ÑAËT QUAÛN LYÙ CÖÔÙC PHÍ ÑIEÄN THOAÏI. 

1. Caøi ñaët coång COM : 

• Treân menu choïn Caøi ñaët  Thoâng soá coång COM  Coång COM thöù 1 

 
• Coång : Choïn COM1, COM2, … tuøy theo coång keát noái vôùi toång ñaøi 
• Toác ñoä : 1200 / 2400 …  / 9600  
• Data : 7 bit hoaëc 8 bit tuøy thuoäc vaøo tham soá  coång RS-232 cuûa toång ñaøi 
• Parity : no, odd, even , …  

2. Caøi ñaët thoâng soá heä thoáng : 

• Treân menu choïn Caøi ñaët  Thoâng soá heä thoáng 

 
• Trong phaàn < Thoâng soá chung > caàn quan taâm ñeán caùc tham soá sau : 

 Thueá VAT (%) : soá phaàn traêm thueá VAT 
 Nhoùm taêng default : choïn coät taêng soá lôïi nhuaän cho phí ñieän thoaïi 
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 Tænh : choïn ñòa danh taïi nôi thieát laäp toång ñaøi 
 Soá ngaøy xem : laø soá ngaøy xuaát hieän ôû nôi xuaát cöôùc phí keå töø ngaøy hieän taïi 
 Soá leû thaäp phaân : ñeå khoâng coù phaàn leû trong hoùa ñôn, neân choïn laø -2 

• Trong phaàn < Toång ñaøi > caàn quan taâm ñeán caùc tham soá sau : 

 
 In töùc thôøi maëc ñònh : Toång ñaøi vöøa xuaát cöôùc ra maùy tính vaø vöøa xuaát cöôùc ra maùy in 
 Khoâng tính cuoäc goïi <  :  neáu nhoû hôn soá giaây naøy, heä thoáng seõ khoâng tính cöôùc. 

• Trong phaàn < Tính noäi haït >  : 

 
3. Caøi ñaët baûng cöôùc ñieän thoaïi : 

• Treân menu choïn Data  Quaûn lyù giaù cöôùc  Baûng maõ höôùng goïi 
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Baûng cöôùc naøy ñöôïc caøi ñaët theo giaù cöôùc böu ñieän, tuy nhieân vì nhieàu lyù do khaùc nhau ta phaûi thay 
ñoåi baûng giaù naøy cho phuø hôïp. Ñeå thay ñoåi, ta thöïc hieän caùc böôùc sau ñaây : 

 Choïn nôi ñeán caàn thay ñoåi giaù cöôùc 
 Click vaøo nuùt  [ Söûa chöõa ] 
 “Ñôn vò thôøi gian ñaàu” : ñieàn soá giaây (block) cho ñôn vò ñaàu 
 “Ñôn vò thôøi gian keá” : ñieàn soá giaây (block) cho ñôn vò keá 
 Nhaäp giaù cöôùc vaøo öùng vôùi ñôn vò thôøi gian ñaàu vaø ñôn vò thôøi gian keá 
 Click vaøo nuùt “Caäp nhaät” ñeå löu laïi. 

• Ñeå thay ñoåi giaù cöôùc VoIP ( 171, 178, 177, … ) , trong oâ Operator choïn nhaø cung caáp töông 
öùng vaø tieán haønh caùc böôùc neâu treân. 

4. Khai baùo theâm nhaân vieân. 
Vì moät lyù do naøo ñoù baïn muoán theâm hay bôùt nhaân vieân baïn thöïc hieän caùc thao taùc sau: 

 Click vaøo Data 
 Choïn danh baïn ñieän thoaïi. 
 Choïn coâng ty hay phoøng ban. 
 Click vaøo bieåu töôïng theâm nhaân vieân( Hình ñaàu ngöôøi maøu vaøng) 

 

) Tel: 35.500.234  Fax: 35.500.200           Trang 4 



HDSD phần mềm quản lý cước điện thoại(Ver Office) 

Coâng ty Vieãn Thoâng Thaønh Phoá (www.citytelecom.com.vn

 Maøn hình seõ hieän ra moät haøng thoâng tin veà nhaân vieân vaø sau ñoù chuùng ta Double Click 
vaøo bieåu töôïng ñoù vaø thay ñoåi thoâng tin theo nhu caàu söû duïng. 

 Neáu chuùng ta xoùa moät nhaân vieân naøo ñoù thì baïn thao taùc nhö treân vaø nhaán nuùt Delete 
vaø OK. 

5. In hoùa ñôn theo maùy nhaùnh. 
Ñeå thöïc hieän in hoùa ñôn cuûa moät hay nhieàu maùy nhaùnh.Ñeå chuùng ta xem maùy nhaùnh ñoù ñaõ söû duïng 
bao nhieâu tieàn cho ñieän thoaïi. Qua ñoù chuùng ta coù theå ñieàu chænh vaø baùo caùo. Chuùng ta thöïc hieän 
caùc böôùc nhö sau. 

 Click vaøo bieåu töôïng in hoùa ñôn ñieän thoaïi. 
 Choïn in hoùa ñôn theo maùy nhaùnh. 
 Trong haøng maùy nhaùnh : Nhaäp soá noäi boä maø ta khai baùo ( cuõng nhö muoán theo doõi) vaøo. 
 Trong oâ soá goïi khoâng caàn nhaäp( Neáu chuùng ta nhaäp soá ñieän thoaïi vaøo thì heä thoáng seõ lieät 

keâ soá ñieän thoaïi noäi boä ñoù, trong khoaûng thôøi gian maø chuùng ta khai baùo thöïc hieän bao 
nhieâu cuoäc vôùi moät soá ñieän thoaïi treân vaø heát bao nhieâu tieàn) 

 Choïn thôøi gain baét ñaàu vaø thôøi gian keát thuùc maø baïn muoán baùo caùo. 
 OÂ döôùi haøng ngaøy thaùng, baïn khai baùo ñöa döõ lieäu cöôùc ra maùy in hay xuaát ra file Exel. 
 Trong phaàn choïn loaïi goïi: Di chuyeån taát caû caùc dòch vuï sang beân phaûi. 
 Neáu baïn quaûn lyù maùy nhaùnh theo maõ soá caù nhaân thì baïn Check vaøo oâ Authority( Neáu baïn 

quaûn lyù cöôùc theo soá noäi boä thì khoâng caàn check vaøo oâ naøy) 
 Sau ñoù choïn caùc thoâng soá tuøy chonï ôû beân döôùi. 
 Nhaán nuùt bieåu töôïng maùy in ôû döôùi. 
 Sau ñoù coù 2 löïa choïn : coù theà in ra luoân vaø xem tröôùc khi in. 

6. In hoùa ñôn ñieän thoaïi theo nhoùm. 
Ñeå quaûn lyù hoùa ñôn ñieän thoaïi theo nhoùm hay theo phoøng ban, baïn thöïc hieän nhö sau: 

 Click vaøo bieåu töôïng in hoùa ñôn ñieän thoaïi. 
 Choïn in hoùa ñôn ñieän thoaïi theo nhoùm. 
 Click chuoäc phaûi vaøo phoøng ban vaø nhaán vaøo ñaët côø in 
 Nhaán bieåu töôïng maùy in  
 Maøn hình xuaát hieän cöûa soå nhö sau: 
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 Sau ñoù chuùng ta thao taùc gioáng nhö phaàn treân. 
7. In hoùa ñôn theo trung keá. 
Thoâng thöôøng khi ñeán thaùng thì böu ñieän seõ gôûi bill cöôùc veà nhaø. Vaø treân ñoù böu dieän thoáng keâ cöôùc 
phí trong thaùng treân line ñieän thoaïi ñoù laù bao nhieâu. Döïa treân cô sôû ñoù chuùng ta thoáng treân line 
trung keá cuûa mình coù chính xaùc vôùi böu ñieän khoâng, chuùng ta thao taùc nhö sau: 

 Click vaøo bieåu töôïng in hoùa ñôn ñieän thoaïi. 
 Choïn in hoùa theo trung keá.. 
 Maøn hình xuaát hieän khung nhö sau : 

 
 Trong oâ trung keá: Baïn nhaäp soá trung keá vaøo( Khoâng phaûi soá ñieän thoaïi) 
 Taát caû caùc thoâng soá coøn laïi baïn thao taùc nhö treân. 

8. Thoáng keâ cöôùc phí ñieän thoaïi. 
Ñeå kieåm tra xem trong khoaûng thôøi gian naøo ñoù, toaøn heä thoáng ñaõ söû duïng bao nhieâu tieàn ñieän thoaïi 
ta thao taùc nhö sau: 

 Click vaøo bieåu töôïng in hoùa ñôn ñieän thoaïi. 
 Thoáng keâ cöôùc phí ñieän thoaïi. 
 Maøn hình xuaát hieän khung nhö sau : 
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 Taát caû caùc thoâng soá coøn laïi baïn thao taùc nhö treân. 
 
 

TÍNH NAÊNG MÔÙI CHO VERSION 10.00 
 

A. Danh baï noäi boä: 
 

1. Töï ñoäng caäp nhaät danh baï noäi boä: 
Khi chöông trình nhaän cöôùc töø toång ñaøi seõ tính cöôùc vaø ñoàng thôøi kieåm tra maùy naøy ñaõ coù 
trong danh baï chöa. Neáu chöa coù, chöông trình seõ töï ñoäng theâm vaøo danh baï noäi boä nhö 
sau: 
- Cuoäc goïi duøng maõ: Theâm vaøo danh baï maùy môùi coù soá ñieän thoaïi laø 999 vaø maõ laø maõ 

vöøa nhaän, teân laø “khoâng teân”. 
- Cuoäc goïi khoâng duøng maõ: theâm vaøo danh baï maùy môùi coù soá ñieän thoaïi vöøa nhaän vaø 

maõ laø troáng, teân laø “khoâng teân”. 
Maùy môùi ñöôïc theâm vaøo nhoùm ñaàu tieân trong danh baï neáu version Office (Nhoùm 
Technical), vaøo nhoùm thöù hai neáu laø version Hotel (Floor 1). 
Baïn coù theå vaøo File -> Danh baïnoäi boä ñeå khai baùo laïi teân vaø soá ñieän thoaïi, di chuyeån 
maùy naøy sang nhoùm khaùc duøng thao taùc keùo thaû. 
 

 
 
2. Khai baùo ñòa chæ email vaø nhoùm baùo caùo qua email: 
Baïn vaøo danh baï noäi boä vaø khai baùo chi tieát cho moät maùy nhö sau: 

 
 

Nôi muïc mail baïn seõ vaøo nhoùm mail vaø ñòa chæ email cuûa maùy naøy. Tuøy theo ñaëc tính 
cuûa nhoùm mail maø chöông trình seõ goïi cuoäc goïi töùc thì vaø baùo caùo haøng thaùng cho chuû 
maùy naøy qua email. 
 

B. Khai baùo thoâng soá cho taùc vuï mail: 
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Baïn vaøo Caøi ñaët -> Thoâng soá heä thoáng vaø choïn tab Mail 
 

 
 

1. Profile mail: Profile cuûa user mail defaul trong Outlook Express. Chöông trình seõ söû 
duïng user naøy ñeå gôûi mail ñi. 

2. ÑC mail baùo caùo: Chöông trình seõ gôûi tôùi ñòa chæ mail naøy caùc caûnh baùo cuûa chöông 
trình. 

3. ÑC mai baùo cöôùc: Chöông trình seõ gôûi tôùi ñòa chæ mail naøy caùc baùo caùo cöôùc ñònh kyø, 
caùc baùo caùo cöôùc haøng thaùng cuûa moãi maùy hay cöôùc töùc thôøi neáu maùy naøy khoâng coù 
ñòa chæ email rieâng. 

4. Mail chaïy: neáu choïn thì taùc vuï mail seõ hoaït ñoäng, neáu khoâng choïn thì caùc taùc vuï mail 
seõ ngöng. 

5. Baùo caùo (phuùt): thôøi gian gôûi caùc baùo caùo ñònh kyø. 
Chöông trình seõ gôûi vaøo ÑC mai baùo cöôùc toång soá cuoäc goïi vaø toång tieàn tính töø ñaàu 
ngaøy hay luùc baét ñaàu chöông trình ñeán thôøi ñieåm baùo caùo hieän taïi maø chöông trình 
nhaän ñöôïc töø toång ñaøi. 
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6. Ngaøy baùo caùo cöôùc: Ngaøy maø moãi thaùng chöông trình seõ töï ñoäng taïo baùo caùo cöôùc 
cho moãi maùy cuûa toaøn boä heä thoáng vaø gôûi mail cho töøng maùy (neáu maùy chöa coù hay 
khoâng coù ñòa chæ email thì chöông trình seõ gôûi vaøo ÑC mai baùo cöôùc). Soá lieäu seõ tính 
töø ngaøy baét ñaàu thoáng keâ treân cöûa soå “Danh saùch toång hôïp cuoäc goïi cho caùc maùy” 
ñeán ngaøy hoâm qua. Sau khi gôûi baùo caùo xong chöông trình seõ laáy ngaøy naøy thay vaøo 
ngaøy baét ñaàu thoáng keâ treân cöûa soå “Danh saùch toång hôïp cuoäc goïi cho caùc maùy” vaø 
tính laïi danh saùch naøy. Do ñoù thaùng sau chöông trình seõ baùo caùo soá lieäu tieáp theo. 

7. Toùm taét: Neáu khoâng choïn thì soá lieäu cöôùc cho moãi maùy haøng thaùng laø  daïng chi tieát. 
 

 

 
Neáu choïn thì soá lieäu cöôùc cho moãi maùy haøng thaùng laø daïng toùm taét. 
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Sau khi chaïy baùo caùo thaùng xong, chöông trình seõ gôûi mail vaøo ñòa chæ ÑC mai baùo cöôùc 
baùo soá baùo caùo ñaõ gôûi 

 
8. Loaïi nhoùm mail: 

- Nhoùm mail : Teân nhoùm mail. Moãi maùy trong danh danh baï seõ öùng vôùi moät 
nhoùm naøy. 

- Noùi (giaây): Neáu cuoäc goïi coù thôøi gian noùi chuyeän  lôùn hôn coät naøy, thì chöông 
trình seõ gôûi soá lieäu chi tieát cuoäc goïi naøy tôùi ñòa chæ mail cuûa chuû cuoäc goïi. Neáu 
coät naøy = 0 nghóa laø khoâng xeùt thôøi gian noùi chuyeän. 
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- Cöôùc: Neáu cuoäc goïi coù cöôùc lôùn hôn coät naøy, thì chöông trình seõ gôûi soá lieäu 
chi tieát cuoäc goïi naøy tôùi ñòa chæ mail cuûa chuû cuoäc goïi. Neáu coät naøy = 0 nghóa 
laø khoâng xeùt cöôùc cuoäc goïi. 

 

 
 

- Toång: Neáu toång tieàn coäng doàn caùc cuoäc goïi lôùn hôn coät naøy, thì chöông trình 
seõ gôûi soá lieäu chi tieát cuoäc goïi tôùi ñòa chæ mail cuûa chuû cuoäc goïi. Neáu coät naøy 
= 0 nghóa laø khoâng xeùt toång cöôùc cuoäc goïi. 

- Mail maëc ñònh: Neáu chuû maùy khoâng coù ñòa chæ mail rieâng (khai baùo trong 
danh baï ñieän thoaïi) thì chöông trình seõ laáy ñòa chæ naøy thay vaøo, neáu ñòa chæ 
naøy troáng seõ laáy ÑC mai baùo cöôùc. 

- Loaïi goïi: caùc cuoäc goïi thuoäc loaïi goïi naøy môùi xeùt caùc ñieàu kieän treân. Ñeå troáng 
laø taát caû caùc cuoäc goïi. 

 
C. Danh saùch toång hôïp cuoäc goïi cho caùc maùy: 
Baïn vaøo menu vaø choïn muïc “Toång cuoäc goïi” hay nhaán nuùt  ñeå môû cöûa soå naøy: 
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Trong cöûa soå naøy, nhaán nuùt  ñeå xoaù caùc soá lieäu toång coäng neáu caàn. 
Muïc ngaøy laø ngaøy baét ñaàu thoáng keâ. Neáu baïn söûa laïi ngaøy thì chöông trình seõ tính laïi soá lieäu 
toång cuûa töøng maùy tính töø thôøi ñieåm naøy tôùi ngaøy hoâm nay (neáu ngaøy baùo caùo thaùng trong thoâng 
soá mail lôùn hôn ngaøy hoâm nay. 
Khi baïn thao taùc check in moät maùy thì soá lieäu toång cuûa maùy trong danh saùch seõ xoaù veà khoâng. 
 
D. Baùo caùo choïn töø danh baï:  
Khi baïn baùo caùo soá lieäu töø muïc “Baùo caùo maùy nhaùnh” hay “Thoáng keâ ñieän thoaïi”, baïn seõ khoâng 
caàn nhôù danh saùch teân cuûa ñieän thoaïi. Ñôn giaûn baïn nhaán vaøo nuùt  ñeå choïn maùy töø danh saùch. 
 

 
Cöûa soå “Baùo caùo maùy nhaùnh” 

 
Cöûa soå  “Thoáng keâ ñieän thoaïi” 
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- Maùy naøo muoán in thì baïn ñaùnh daáu côø P.  
- Nuùt “Choïn taát caû” ñeå ñaùnh daáu taát caû caùc maùy. 
- Nuùt “Ngöôïc laïi” ñeå ñaùnh daáu caùc maùy khoâng ñaùnh daáu, xoaù caùc maùy ñang ñaùnh 

daáu. 
- Nuùt “Coù tieàn” : ñaùnh daáu caùc maùy coù goïi tính töø ngaøy baét ñaàu thoáng keâ. 
- Baïn muoán sort theo coät naøo thì nhaán vaøo ñaàu coät ñoù. 

Chöông trình öu tieân xeùt trong danh saùch tröôùc roài xeùt tieáp khai baùo trong doøng “Maùy 
nhaùnh” hay “Extension. 
 

E. Caùch khai baùo trong Outlook Express:  
Ñeå chaïy ñöôïc chöùc naêng mail, treân maùy phaûi caøi ñaët Outlook Express. 

1. Caøi Outlook Express : 
Neáu treân maùy chöa coù OutLook Express. Vaøo Control panel, choïn Add and remove 
program, choïn Add/Remove Windows components, ñaùnh daáu Outlook Express. Nhaán 
next vaø Windows seõ caøi Outlook Express 
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2. Khai baùo account mail defefault: 
Chaïy Outlook Express vaø choïn Tools -> Account -> Mail vaø Add moât user account 
default (Server mail phaûi hoã trôï POP 3 nhö Yahoo.com.vn, gmail.com,…) 
3. Khai baùo option ñeå chaïy vôùi chöông trình: 
Chaïy Outlook Express vaø choïn Tools ->Option  

 
Set thôøi gian gôûi mail töï ñoäng : khai baùo soá phuùt Outlook Express check and send mail trong 
thoâng soá “Check for new messages every”. 
Choïn tab Send vaø boû ñaùnh daáu Send message immediately vaø Save copy of send messages in 
the ‘Sent Items’ folder. 
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Vaøo tab Sercurity vaø boû ñaùnh daáu Warn me when other applicatios try to send mail as me. 

 
 
Vaøo tab Read vaø choïn Font. Khai baùo nhö sau: 
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Treân ñaây laø moät soá thao taùc thöôøng söû duïng trong heä thoáng tính cöôùc ñieän thoaïi maø Coâng Ty 
Citytelecom cung caáp. Neáu coù vaán ñeà truïc traëc khi thao taùc xin baïn ñöøng ngaàn ngaïi goïi soá 
08.35.500.234 gaëp phoøng kyõ thuaät. 
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